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Definition of Computer 
 Computer is an electronic device, which performs logical and numerical terms. It cannot 
perform them selves. It process instruction and returns output according to your input. 
 
 
 
 Computer works on GIGO System 

GIGO - Good In Good Out                   GIGO – Garbage In Garbage Out 

 

Organization of Computers: 
The computer is organized into four units as shown in figure: 

 

 

 

 

 

 

 

 

Input Unit: 
It is used for transferring user command or data to the computer. It is a device, which 

used for sending of data of computer. An input device converts input information into suitable 
binary form acceptable to a computer. Such as : 

1. Keyboard 
2. Mouse 
3. Light Pen 
4. Joy stick 
5. Scanner 
6. MICR (Magnetic Ink Character Reader) 
7. OBR (Optical Bar Code Reader) 
8. OCR (Optical Card Reader) 
9. OMR (Optical Mark Reader) 
10. Touch Screen 

1. Keyboard: Keyboards are the most widely used input devices. Generally a keyboard has 

105 keys. It features 12 function keys arranged at the top of the keyboard, and larger 
Backspace key, a numeric keypad, a curser movement keypad, toggle lights, shift keys, ctrl 
keys, Caps Lock key, Num Lock key, Spacebar key, Enter key, Alphabetical keys etc. 

2. Mouse: This input device is categorized as an pointing device because it is used to point 

and select an option on monitor. A pointer on the screen follows the movements of the 
mouse. The mouse can be used to open menus, select text for editing, move objects on the 
screen, draw images or diagrams etc. 

3. Light Pen: It can be used to select an option by simply pointing at it or drawing figures 

directly on the screen. The light pen which is a pen like device,  has a photo detector at its 
tip. The detector can detect changes in the brightness of the screen. The light pen is 

INPUT OUTPUT PROCESS 

 

 ALU 

 CU 

Register 

INPUT OUTPUT 

Primary Memory 

Secondary 

Memory 



- 4 -                      M.Sc. (Ag.) Ist Sem(Computer Application in Agriculture) (Common Paper) 

Prepared By  :  SUSHANT SRIVASTAVA (Computer Department) KAPG College, Prayagraj 

connected to the computer by a cable. Light pens are useful for drawing graphics in 
Computer Aided Design Software. 

4. Joy Stick: This is used to play computers games, which is connected to a game port. 

5. Scanner: These are the eyes of your computer. They can see the images or printed text 

and translate them into binary code. They contain a camera, which is made up of thousand 
of tiny cells, called charge coupled cells(CCD). Each CCD detects whether a small part of 
the image is either light or dark. It transmit the data to the CPU, which then creates the 
images. 

6. Magnetic Ink Character Reader (MICR): This is a device that identifies a 

character that is written with the ink that contains particles of magnetic material. This device 
is mainly used to read the bank cheque. 

7. Optical Bar Code Reader(OBR): This is used to read to different kind of vertical 

lines known as bars which signify more information. 

8. Optical Character Reader(OCR): It is used read any printed text. They can 

interpret hand made marks, handwritten characters, machine printed text, and special 
symbols and codes. They read characters at the rate of around 2600 characters per second. 

9. Optical Mark Reader(OMR): This device is used to recognize the marks made by 

a pencil or pen on a specially designed paper. These devices are also known as Mark 
Sense Reader. These devices are used in competitive exams. 

Output Device  
 It is used for getting result from computer after processing of data. The computer 

sends information to an output device in the binary form. An output device converts it into form 
convenient to users such as printed form. Such as : 

 
1. VDU (Visual Display Unit) like monitor 
2. Printer 
3. Plotter 
4. Speaker 
5. Projector 
6. LED (Light emitting Diodes) 
7. Microfilm  

(1) VDU (Visual Display Unit) 
 Visual Display Unit is a device, which provide of result of data in interactive way. It gives 
graphical output from computer like your display device monitor. Graphic display is made up of 
a series of dotes called pixels which pattern produce the image. Each dot on the screen defined 
as a separate unit  which can be directly addressed. 
There are two categories of display screen technology 

1. CRT (Cathode Ray Tube) 
2. LCD (Liquid Crystal Display) 

• CRT (Cathode Ray Tube): The main component of CRT terminals is the electron 

gun, the electron beam controlled by an electro magnetic field and a phosphor coated 
display screen. 

• LCD (Liquid Crystal Display): In LCDs a liquid crystalline material is situated 

between two glass or plastic plates, the front plate is transparent and the back is 
reflective. There is a coating of thin film on the front plate. LCD is now applied to display 
terminals. The major advantage of LCD is the low energy consumption. This also have a 
color capability but the image quality is relatively poor.  



- 5 -                      M.Sc. (Ag.) Ist Sem(Computer Application in Agriculture) (Common Paper) 

Prepared By  :  SUSHANT SRIVASTAVA (Computer Department) KAPG College, Prayagraj 

(2)Printers 

 It produces output on paper. It produces hard copy of output. There are large variety of 
printers available, which can be classified according to the print quality and the printing speeds. 
These are : 

(a) Printing Technology- impact printers vs. non-impact printers: 

1. Impact printers use variations of standards typewriter printing mechanism where a 

hammer strikes paper impact printers use variations of standards typewriter printing 
mechanism through inked ribbon. Impact printers use electromechanical mechanism that 
causes hammers or pins to strike against a ribbon and paper to print the text 

2. Non – Impact Printers do not use electromechanical printing head to strike 

against ribbon and paper. They use thermal, chemical, laser beam or inkjet technology for 
printing the text. Non-impact printer is faster than an impact type printer. Non-impact laser 
printer uses chemical, heat or electrical signals to etch or induce symbols on paper. 

Central Processing Unit (CPU) : The CPU perform all arithmetical and logical 

operation. It is also called Microprocessor. There are three main parts of C.P.U  
1. A.L.U - Arithmetic and logic unit  2. C.U. - Control Unit  3. Register (memory) 

1. Arithmetic-logic unit (ALU) : It performs arithmetic and logical operation Such as 

addition subtraction multiplication and division and as well as comparison. 

2. Control Unit (CU) : It controls all the activities, which are being carried out with the 

computer. 

3. Register: It stores the data and the instruction as well as the output after processing. It 

is very small unit but speed very fast. 

Storage Device: 
This section is used to store the data. Computer has memory in which the data can be 
stored for future use.  

 

Characteristics or Advantage or Properties of Computer 
Some reasons for computer use 

1. Speed – Computer can process millions of instruction in a fraction of a second. The 
speed of computer is measured in nano second (109).  

2. Accuracy – It is perform each and every task and computation with 100% accuracy. 
3. Diligence – Computer can perform the task repeatedly for N number of times without 

degradation of processing speed. 
4. Versatility – It can be use in many field like education, Engineering, Medical, defense etc.   

5. Storage – It stores huge amount of data in a limited area. 

Disadvantages of Computer 

1. It is dependent upon human begins. 
2. It has no Imagination and institution of these own. 
3. It will not work without electricity. 

4. It cannot detect flow and error in logic.  

BIT 

Computer performs each and every task in binary number (0 & 1) and 0 & 1 is electronic 
signal. 0, 1 is a binary digit and each digit of binary is called one bit. BIT is a small unit of 
memory. The capacity of main memory is measured in KB or Megabyte (MB). The amount of 
information that can be held in the main memory is known as memory capacity. 
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  4 Bit    =  1 Nibble  
  8 Bit    =  1 Byte 
  1024 Byte (210)  =  1 Kilobyte (KB) 

1024 Kilobyte (210)  =  1 Megabyte (MB) 
1024 Megabyte (210)  =  1 Gigabyte (GB) 

Classification of Computers 
Computers are classified according to their sizes and their capabilities. They are :  

1. Micro Computer 
2. Mini Computer 
3. Mainframe Computer 
4. Super Computer 
5. Lap Top/ Note Book Computers 

Micro Computer: 
 This is also known as Personal computer. A micro computer is the smallest general 
purpose processing system. Functionally it is similar to any other large system. Usually  it is 
designed for use by one person at a time. 

Mini Computer: 
A mini computer is medium sized computer that is more powerful than a microcomputer. 

An important distinction between a microcomputer and a minicomputer is that a minicomputer is 
usually to serve multiple users simultaneously.    

Main Frame Computer:  
These are suited to big organization to manage high volume application. Mainframes are 

also used as central host computers in distributed systems.   

Super Computer: 
These are the most powerful computers. In supercomputers speed is measured as tens 

of millions of operations per second. The supercomputers are used in applications include large 
scale numerical problems in scientific and engineering disciplines like weather forecasting, 
atomic research, space research etc. 

Lap Top/ Note Book Computers: 
 These are the computers, which are small in size and weigh few kgs. These computers 
can be carried from one place to another easily. The people who are always on the move 
mostly use these. It has an LCD screen and has rechargeable batteries. 

Computer Language 
Programming languages are used in order to communicate instructions and commands 

to a computer for solving problems. Learning a programming language requires learning the 
symbol, words and rules of the language. The process of writing a program is called 
programming.   
 

Machine Language  
This is a sequence of instructions written in the form of binary numbers consisting of 1’s, 

0’s to which the computer responds directly. The machine language was initially referred to as 
code, although now the term code is used more broadly to refer to any program text. 
           An instruction prepared in any machine language will have at least two parts. The first 
part is the command or Operation, which tells the computer what functions, is to be performed. 
All computers have an operation code for each of its functions. The second part of the 
instruction is the operand or it tells the computer where to find or store the data that has to be 
manipulated. 

Advantage of Machine Language 
It is faster in execution since the computer directly starts executing it. 
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Disadvantage of Machine Language 

It is difficult to understand and develop a program using machine language. Anybody 
going through this program for checking will have a difficult task understanding what will be 
achieved when this program is executed. 

Assembly Language  
When we employ symbols (letter, digits or special characters) for the operation part, the 

address part and other parts of the instruction code, this representation is called an assembly 
language program. This is considered to be the second-generation language. 
           Machine and Assembly languages are referred to as low-level languages since the 
coding for a problem is at the individual instruction level. 
          An assembler is a translator, which takes its input in the form of an assembly language 
program and produces machine language code as its output. 

Advantage of Assembly Language 

Writing a program in assembly language is more convenient than in machine language.  
Instead of binary sequence, as in machine language, it is written in the form of symbolic 
instructions.  

Disadvantages of Assembly Language 

Assembly language (program) is specific to particular machine architecture. Assembly 
languages are designed for specific make and model of a microprocessor. It means that 
assembly language programs written for one processor will not work on a different processor. 

 

High-level Language 

We have talked about programming languages as COBOL(Common Business Oriented 
language), FORTRAN(Formula Translation) and BASIC(Beginners All Purpose Symbolic 
Language). They are called high level programming languages.  

The time and cost of creating machine and assembly languages was quite high. Since a 
high-level source program must be translated first into the form that machine can understand, 
this is done by software called Compiler, which takes the source code as input and produces as 
output. High Level Language are also called Third Generation Language.  

Advantage of High-level Language 

There are four major advantages of High Level Language : 

Readability : Programs written in these languages are more readable than assembly 

and machine language. 

Portability : Programs could be run on different machines with little or no changes. 

We can therefore exchange software leading to creation of programs library. 

Easy Debugging : Errors could easily be removed. 

Easy Software Development : Software could easily be developed. Commands of 

programming language are similar to natural languages. 

Fourth Generation Language 

Most third generation languages are procedural languages. This means that the 
programmer must specify the steps, which is the procedure, the computer has to follow in a 
program. By contrast, most fourth generation languages are non-procedural languages. 

Difference between Compiler and interpreter 

Compiler Interpreter 
1) Scans the entire program first and then 
translates it into machine code. 

Translates the program line by line. 
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2) Converts the entire program to machine 
code; when all the syntax errors are 
removed execution takes place. 

Each time the program is executed, every 
line is checked for syntax error and then 
converted to equivalent machine code. 

3) Slow for debugging (removal of 
mistakes from a program) 

Good for fast debugging 

4) Execution time, is less Execution time is more. 
 

Windows Operating System 
 

Introduction : Operating System is a system software. This acts as an interface between 

the user and the computer. Operating system in computer’s memory is known as booting. 
  Thus the main features of Operating System are: 

1. To act as an interface between user and the computer. 
2. to monitor the use of the resources of computers(Resources can be Hardware or 

software). 
3. To control and coordinate Input and Output devices. 
4. To manage the program and data files i.e. to store, to retrieve, to delete files. 

             5.To help application programs execute commands given by the user. 
Ex.- Microsoft Disk Operating System(MSDOS), Microsoft Windows 98, MS-Windows 

2003 Server, MS- Word XP, UNIX, LINUX etc. 
 

Different types of Operating System : 
1. Single User  
2. Multi User 
3. Batch Processing 
4. Multi Processing 

5. On Line and Real Time 
1. Single user  

(a)Single User/Single Task : This operating system is designed to manage the 

computer so that only one user can access the machine at a time. Example is MS-DOS 

(b)Single user/ Multi tasking Operating System: Many user can access the 

machine. Microsoft’s Windows and Apple’s MacOS platforms are both examples of oerating 
system that will let a single user have several programs in operation at a time. 

1. Multi-user: A multi-user operating system allows many different usersto take 

advantage of the computer’s resources simultaneously. Unix, VMS and Mainframe 
operating systems are examples of multi-user operating systems. 

2. Batch Processing System: In these kind of systems the user feeds his job into the 

computer and waits for the completion of his job. New job can be started until the old job 
is not completed. 

3. Multi Processing: We are considering the system with more than one processor. 

When e are having more than one processor in the system then tasks cam be actually 
run simultaneously on different processor. 

4. On line and Real Time System: In these kinds of systems the information should 

be retrieved quickly whenever needed and update immediately once a transaction is 
complete. There should not be any delay in the process. Such systems are called real 
time operating system. 
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Use of MS- Word 

MS-WORD 

 Microsoft word is a word processor, 
which process text and words. In MS-Word, 
You can create document, letters, cash 
memos, article etc. It is windows based 
application. The MS-Word file is called 
Document and extension of these files is 
.doc.  
To open MS-Word follow these steps 

1. Click on start button and select 
program from start menu 

2. Click on Microsoft Word from program 
menu, the following MS-Word window 
appears as :  

The MS-Word window contains Menu Bar, 
Standard Toolbar, Formatting Tool Bar, 
Status Bar, Document Window and Cursor. 
Menu bar contains File, Edit View, Insert 
Format, Tools, Table, Window and Help Menu 

Contents of file Menu 

• New 

• Open 

• Close 

• Save 

• Save as 

• Save as web page 

• Page Setup 

• Print preview 

New :  
It used for crating new document. For 

creating new  
1. Click on file menu and select new 

option. The new document dialog 
box appears. 

2. Select blank document and click on 
OK button.  

 

Open : 
 By using this option you can open 

any existing file. To open existing 
1. Click open from file menu. The 

open dialog box appears as 
2. Select your file or type name of file 

in file name text box and click on 
Open button. 
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Save :  
Under this option you can save of 

active file for further references. To saving 
a file 

1. Click on Save from file menu. The 
Save As dialog box appears as 

2. Type your file in file name text box 
and click on Save button. 

Save As :  
Save command, save a file only 

one time but by using save as option you 
can save a file multiple times on different 
location from same name or on same location with different name. It creates multiple copy of 

current file. You can also use this command to save a file with a password or to protect a file so 
that other cannot change its document.  

Save As web page :  

By using this option you can create a web page of your document. This document 
automatically converts in HTML format. This document open only on web browser like Internet 
Explorer. 

Page Setup :  
When you open of MS- Word document 

then word provide default setting of page like 
margin, paper size etc. We can change these 
settings as per our requirement by using page 

setup option. To change these setting : 
1. Click on Page setup from File Menu. The 

page setup dialog box appears. It has four 
tab Margins, Paper Size, Paper Source & 
Layout.  

2. Change the setting of page like Paper 
Size, Margin, Orientation etc. and click on 
OK. 

 

Print Preview :  
It shows how the page will look when you print the page. 

Contents of Edit menu   

• Undo 

• Redo 

• Cut  

• Copy 

• Paste 

• Find 

• Replace 

• Go to 

Undo:  
If you want to reverse the last command or the delete the last entries you typed by using 

Undo command or press Ctrl+Z. To reverse more than one action at a time. 

Redo :  
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If an action or actions reversed by mistake then you can use Redo command from edit 
menu or press Ctrl+Y. 

Moving and Copying of Text :  
 You can move and copy text within a document, between document and to 

and between other windows based applications. 

For Moving Text 

1. Select text or lines or paragraph, which you want to move in same document or any other 
application. 

2. Click Cut from Edit Menu or press Ctrl+X. 
3. Set the insertion of point where text to be moved and click paste from Edit or Press Ctrl+V. 

For Copying Text 
1. Select text or lines or paragraph, which you want to move in same document or any 

other application. 
2. Click Copy from Edit Menu or press Ctrl+C. 
3. Set the insertion of point where text to be moved 

and click paste from Edit or Press Ctrl+V. 

Finding and Replacing Text : 
 When you want to search or change text in a 
document. You can easily find it using this feature and 
change it using the replace feature of MS-Word. 
For finding text  

1. Click find from edit menu. The Find and Replace 
dialog box appears as : 

2. Type the text to find in find what box. 
3. Choose the direction to search from drop down 

list. And specify the search criteria. 
4. Click the find next button to start search. 

For Replacing Text : 
1. Choose the Replace tab from the Find and 

Replace dialog box. 
2. Type the text to be finds in Find What box 
3. Type the text to replace the earlier used text, in replace with box. 

4. To replace the text, click the replace command button. 

Goto : 
By using Goto option you can directly jump on desired location. It moves the insertion 

point to the items you want to go to. You can move to a page number, comment, footnote, lines 
or other location. 

Contents of View menu   

• Normal Layout 

• Print Layout 

• Web Layout 

• Outline View 

• Toolbars 

• Document Map 

• Full Screen 

• Zoom 

Normal View :  
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The Normal View provides the easiest way of entering, modifying or formatting text and 
other elements on screen. In this view, the header and footer, graphics, margin are not visible. 
To see normal view click Normal view from view menu. 

Print Layout :  
The print layout view shows the document exactly as it will print. The margins, graphics, 

page number and all other details of the page layout appear on screen. In this view you can see 
how the object will be positioned on the printed page.  

Web Layout :  
It shows the exactly as it will appear on the web browser like Internet explorer.  

Outline View :  
It shows the structure of document. The outline view creates document outlines and 

makes it easy to look at the structure of a document. In this view, the document is collapsed to 
the main headings if the document is formatted according to MS-Word headings style.  

Toolbars :  
This option is used enable or disable any tool (Bar) like- Title Bar, Formatting Tool Bar, 

Status Tool Bar etc. 

Document Map :  
Document Map is a navigation tool in MS-Word that helps the user to move through long 

documents like reports, proposal and long tables. Using document’s headings as navigation 
points, the document map splits the screen in two parts so that the headings are on the left and 
the document is on the right. You can quickly jump to a location in the document by clicking a 
heading on the left.  

Header and Footer : 
Header and footer put the repetitive information in the top and bottom margins of a 

document. A header can consist of text or graphics and appears at the top of every page and 
footer appears at the bottom of every page. 

To creating header and footer  
1. Click header and footer from the View menu. 
2. The header and footer area is activated and header and footer toolbar appears.  

Zoom :  
The zoom feature of MS-Word lets you increase or decrease the size of the display. 

Contents of Insert Menu  

• Break 

• Page Number 

• Date and Time 

• Auto Text 

• Symbols 

• Comment 

• Footnote 

• Picture  

• Text box  

• Files 

• Object 

• Bookmark 

• Hyperlinks 

Break  
Under this option you can inert number of pages into document. For insert page click 

Break from Insert menu, select break and click on OK. 
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Page Number :  
Under this option you insert page number on 

each page. It inserts page numbers that 
automatically update when you deletes or add pages. 
To insert page number 

1. Click page number from insert menu, the insert 
page number dialog box appears as : 

2. Select the alignment (such as left right or 
center) of page number and select position of 
page number (Top or Bottom) and click on OK.  

Date and Time :  
Using this option you insert current date and time in 
different format into document. 

Auto Text :  
From auto text, you insert auto text entries from list such as thanks, Sincerely yours etc. 

Comment :  
If you want explain or give description on any word or picture then you can use 

comment. Comment is display when you point at that word. 
To insert the comment  

1. Set the insertion of point where you want to insert comment 
2. Click comment from insert menu. Type the comment in bottom of page. 
3. Click on close button.  

Footnote :  
Comment is display only on computer. It is not print on 

paper but footnote prints on the paper in the bottom of page or 
end of document. To insert footnote 

1. Click where you want to insert the note reference mark.  
2. On the Insert menu, click Footnote. 
3. Click Footnote or Endnote. 
4. Under Numbering, click the option you want.  
5. Click OK.  
6. Word inserts the note number and places the insertion 

point next to the note number.  
7. Type the note text. 
8. Scroll to your place in the document and continue typing.  

Picture:  
To insert a picture follow the steps given below: 

1. Point the cursor to the location where you want to insert the picture and then click on to 
Insert option available in the menu bar. 

2. Now click on to Picture option you will get a sub- menu. 

Clip Art: Click on to clip art you will get a menu, which shows different categories of 

available pictures. 

From file:  
1. Point the cursor to the location where you want to insert picture and click on to                     

Insert→ Picture → From File 

2. Now give the path of the picture file, where the picture you want to insert in your 
document is stored. 

Symbols :  
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The Symbol dialog box provides an extensive list of symbols and characters you can 
insert:  

To insert a symbol 
1. Click where you want to insert the symbol. 
2. On the Insert menu, click Symbol, and then click the Symbols tab. 
3. In the Font box, click the font that you want. 
4. If you want to get a close-up view of a symbol, click it.  
5. Double-click the symbol that you want to insert. 

Object :  
By using this command you insert any object into document such as Paint, Excel 

Worksheet etc. 

Book Mark :  
A bookmark is a location or selection of text that you name or reference purposes. 

Microsoft Word marks the location with the name you specify. 
1. Select an item you want a bookmark assigned to, or click where you want to insert a 

bookmark. 
2. On the Insert menu, click Bookmark. 
3. Under Bookmark name, type or select a name. 
4. Click Add.  

Hyperlink : 
To create hyperlink  

1. Select the text or object you 
want to display as the 
hyperlink. 

2. Select the hyperlink option 
from the insert menu. The 
Insert Hyperlink dialog box 
appears as: 

3. Browse the file or web page 
name and click on OK button. 

Use of MS-Excel 
Introduction: MS-EXCEL is windows based spreadsheet (worksheet) package. When 

calculations are made on paper and certain data must be changed, then the entire work must 
be recalculated and re-written. If a spreadsheet package is used then the recalculation is 
automatic. The details of bank passbook, tax inventory, purchase and sales can also be 
maintained using a spreadsheet package. Lotus 123, MS-Excel etc. is spreadsheet packages. 
Extension of excel worksheet is .xls. 

 

Name box: Displays the address of the 
current cell. 
Row Headers: There are 65536 rows 
numbered as 1,2,3 … 65536. First row 
number is 1 and the last row number is 
65536. To go to cell in last row, press 
End and Down arrow key, to return to 
cell in the first row, press End and up 
arrow key. 
Column Headers: There are 256 
columns numbered as A,B,C,….Z, AA 
and AB..AZ, BA, BB,… IV. First column 
name is A and last column name is IV. 
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To go to the last cell in first column, press End and Left Arrow key. 
Sheet Tabs: Displays the sheet names. Each worksheet is named as Sheet1, Sheet2 and 
Sheet3. 
Cell and Cell Address: The intersection of row and column is called as a cell. The cell address 
consists of the column letter and row number. For example, the first cell in the first column and 
first row. First column name is A and first row number is 1. Therefore the first cell address is A1. 
The total cells in worksheet are 256*65536. 
Enter an Edit Data: Any entry can be made in the active cell. Entries can be of 4 different 
types: 

1. Text: Text in a cell can include any combination of letters, numbers and keyboard  
symbols. A cell can contain 32000 characters. To store a number as a text entry, use 
apostrophe (‘) as the first character. 

2. Number: Numbers include digits from 0 to 9 and some special charaters like $, %, +, - 
etc. When a formatted number does not fit in a cell #### is displayed. 

3. Logical Values: Logical values, TRUE or False can be entered in the cells. 
4. Formulas: Formulas are entered into the cell to perform calculations. A formula begins 

with an equal (=) sign or plus symbol (+). 
                     To edit the cell content press F2 function key or double click on that cell. 

Contents of Edit menu   

• Undo 

• Redo 

• Cut  

• Copy 

• Paste 

• Fill 

• Clear 

• Delete 

• Delete sheet 

• Move or copy sheet 

• Find  

• Replace 

• Go to 

Auto Fill  
The Auto Fill feature of MS-Excel will save data entry time by expanding series of 

numbers, days of week, different months, etc. from a given cell to adjacent ones. This is 
achieved using Fill Handle. 
1. To generate a serial numbers 1,2,3,4… with the increment 1, type 1 in any cell and 

Ctrl+Drag the fill handle down or right, this will increase the number by 1 in each cell and 
Ctrl+Drag the fill handle up or left will reduce number by 1 in each cell. Instead of 1, any 
other starting number can also be entered. 

2. We can also generate the weekday names like Sunday, Monday…etc.  
Example: 

1.Enter MONDAY in cell E20. 
2.Drag the auto fill handle till the cell K20. 
(The whole range will be filled with days from MONDAY to SUNDAY.) 

This process can also be achieved using Edit→ Fill→Series  

Clear: Deletes the selected object or text without putting it on the clipboard. This command is 

available only if an object or text is selected. 

Move or copy sheet: Moves or copies the selected sheet sheets to another workbook or 

to a different location within the workbook. 
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Contents of View menu   

• Normal  

• Page Break Preview 

• Formula Bar 

• Status Bar 

• Header and Footer 

• Custom view 

• Comments  

• Full Screen 

• Zoom 

Formula bar: Displays the cell content. 

Status bar: Shows or hides the status bar. 

Contents of Insert Menu  

• Cells 

• Rows 

• Columns 

• Worksheets  

• Charts 

• Page Break 

• Function 

• Name 

• Comment 

• Picture  

• Object 

• Hyperlinks 
 

Cells: Inserts cells starting at the insertion 

point. You can choose to shift other cells in 
the table to the right or down. You can also 
insert an entire row or column. 
 

Worksheets: Inserts a new worksheet to 

the left of the selected sheet. 
 

Charts 
Charts are the graphical components of Excel. The data which is entered as tables can be 
viewed in the graphical form as charts which makes the figures of data effective, inserting, easy 
to understand, and easy to analyze and compare data. 
To create chars consider the following example as shown in 
figure below: 
Follow the steps given below to create a chart: 

1. Select the data range of which you want to create the 
chart. 

2. Click on the Chart Wizard option available on the 
standard tool bar. 

3. Now you can select the kind of chart you want to create. 
Click on Next you will get a screen as shown in figure. 

4. Here you can change the data range if you want. Here 
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you can go to the previous step and can make any alterations in the previous step. Here 
now you can select Series in Rows or Columns. Click on to Next you will get the screen 
as shown in figure.  

5. You can the Title to the chart in chart title box. Then you can give the name to represent 
X axis and you can give name to represent Y axis. Click on next. 

6. Now you can select the chart to be displayed in a new sheet or as an object in any of the 
sheets of the workbook. 

7. Now click on to Finish option. You will get a screen as shown in figure. 

 

 FUNCTIONS 
The built-in formulas are called function. The users have to provide the cell references or 

addresses only. These are called arguments of the function that are given between a pair of 
parenthesis like ( ). The functions perform the operation on the given values and return the 
result that is displayed in the same cell where the function was entered. The use of function 
also shortens the formula.  
Example; Suppose you want to add the values of cells C10 through C20. You can the formula 
as: C10+ C11+C12+C13+C14+C15+C16+C17+C18+C19+C20.    

You can get the same result if you use the function instead, like=SUM (c10:c20). 
(i) SUM(num1, num2,….): These functions are used for simple mathematical calculation of 
number data. 

=SUM (num1,num2,…) 

Returns the sum of all the numbers in the list of 
arguments. Example: 

=SUM(A3,G3) 

=SUM(B5,K5) 

SUMIF (range, criteria, sum-range) 
Adds the cells specified by given criteria. 
Range: Range is the range of cells you want evaluated. 
Criteria: Criteria is the criteria in the form of a number, 
expression, or text that defines which cell will be added. 
Example: 

=SUMIF(A1:A4,…) 

(ii) FACT (num): Returns the factorial of a number. 
Example: 

=FACT(5) 

(iii) AVERAGE(): Returns the average of the numeric values in the given range of cells. 
Example: 

=AVERAGE(C7:C10) 

(IV) EXACT (): Compare two text strings and returns TRUE if they are exactly the same, 
otherwise FALSE. It is case-sensitive but ignores formatting differences. 
Example: =EXACT(“poor”,”pour”). 

(V) ABS (number): Returns the absolute value of a number. The absolute value of a number is 
the number without its sign. 
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Number- is the real number of which you want the absolute value. 
Example:  
  =ABS (-162) 

  =ABS (162) 

(VI) EVEN (number): Returns number rounded up to the nearest even integer. Regards less of 
the sign of number, a value is rounded up when adjusted away from zero. If number is an even 
integer, no rounding occurs. 
Number- is the value to round. 
Example:  =EVEN (5.5) 

   =EVEN (5) 

   =EVEN (6) 

   =EVEN (-15) 

(VII) MOD (number, divisor): Returns the remainder after number is divided by divisor. The 
result has the same sign as divisor. 
Number- is the number for which you want to find the reminder. 
Divisor- is the number by which you want to find the remainder. 
Example-  =MOD (15,2) 

   =MOD (15, -2) 

 
(VIII) SQRT (number): Return a positive square root. 
Number-is the number for which you want the square root. If number is negative, SQRT returns 
the #NUM! Error value. 
Example-   =SQRT (100) 

 
(IX) CONCATENATE (text1, text2, … ): Joins several text item. The “&” operator can be used 
instead of CONCATENATE to join text item. 
Text1, Text2…- are 1 to 30 text items to be joined into a single text item.The text item can be 
text strings, numbers, or single-cell references. 
Example:   =CONCATENATE (“SOFT”,”WARE”) 

 
(X) PROPER (Text):  
Capitalizes the fist letter in text and any other letters in text that follows any character other than 
a letter. It converts all other letters to lowercase.  
TEXT –is text enclosed in quotation marks, a formula that returns text, or a reference to a cell 
containing the text you want to partially capitalize. 
Example:   

= PROPER (‘ the high QUALITY’)  

(x) MAX (): Returns the largest value in the given range. 
Example: 
   =MAX(C7:C10) 

(xi) MIN (): Returns the lowest value in the given range. 
Example: 
   =MIN(C7:C10) 

(xii) COUNT (): Count the number of cell addresses containing the data. 
Example:  =COUNT (C7:C10) 

(xiii) UPPER (): Convert the text in a cell address to capital letters. 
Example:  =UPPER(C7) 

(xvi) LOWER ():Convert the text in a cell address to small letters. 
Example: 
   =LOWER(C7) 
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Contents of Data Menu  

• Sort 

• Filter 

• Form 

• Subtotal 

Sort 
Arranges the information in selected rows or lists alphabetically, numerically, or by date. 

Filter 

Filtering is a quick easy way to find and work with a subset of data in a list 

• Does not rearrange a list 

• Temporarily hides rows 

• Data Query using AutoFilter 
To display an entire subset of the list, the Auto 
Filter command under Filter option on the data 
menu handles fast but simple queries. To use 
this command, the data list must contain a 
header row with column names or field names. 
Example: 
In the list given earlier in this chapter, filter those 
records whose largest than 11000 and less than 
or equal to 15000. 
Step 1: Select cell B4 and from Data menu, 
choose Filter and then choose AutoFilter. 
Drop-down controls appear next to column labels. 
List with AutoFilter Drop-down controls 

Subtotals 
MS-Excel can automatically calculate the subtotal and grand 
total values in a list. When you insert automatic subtotals, 
Excel outlines the list so that you can display and hide the 
details rows for each subtotal. 
          To insert subtotal, you first short your list so that the 
rows you want to subtotal are grouped together.  
Let us consider the list given in figure for using 
subtotal option:  

1. make sure the data you want to subtotal is in 
list format: each column has a label in the first 
row and contains similar facts, and there are 
no blanks rows or columns within the list. 

2. Click a cell or column to subtotal. 
3. Click Sort Ascending or Sort Descending. 
4. On the Data menu, click Subtotals. 
5. In the At each change in box, click the column 

to subtotal. In the example above, you’d click 
the item column. 

6. In the use function box, click the Sum function to calculate the subtotals. 
7. In the Add subtotal to box, select the checkbox for each column that contains values you 

want to subtotal. In the example above, you’d select the sales column. 
8. Click OK, you will get the list as shown in fig. 

s a separate bus interconnect with the CPU 
 

http://searchstorage.techtarget.com/definition/bus
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e-Agriculture 
 
e-Agriculture is a global community of practice that facilitates dialogue, information 

exchange and sharing of ideas related to the use of information and communication 
technologies (ICTs) for sustainable agriculture and rural development. 

Become a member 
As an e-Agriculture member you can contribute blogs and participate in forum 

discussions while subscribing to our newsletter, news and other content updates. 

 

Concept, Applications and Use of ICT in Agriculture 
Information and communication technology in agriculture (ICT in agriculture), also known 

as e-agriculture, is developing and applying innovative ways to use ICTs in the rural domain, 
with a primary focus on agriculture. ICT in agriculture offers a wide range of solutions to some 
agricultural challenges. It is seen as an emerging field focusing on the enhancement of 
agricultural and rural development through improved information and communication 
processes. In this context, ICT is used as an umbrella term encompassing all information and 
communication technologies including devices, networks, mobiles, services and applications; 
these range from innovative Internet-era technologies and sensors to other pre-existing aids 
such as fixed telephones, televisions, radios and satellites. E-agriculture continues to evolve in 
scope as new ICT applications continue to be harnessed in the agriculture sector. More 
specifically, e-agriculture involves the conceptualization, design, development, evaluation and 
application of innovative ways to use ICTs in the rural domain, with a primary focus on 
agriculture. Provisions of standards, norms, methodologies, and tools as well as development 
of individual and institutional capacities, and policy support are all key components of e-
agriculture. 

 

http://e-agriculture.org/user/register
https://en.wikipedia.org/wiki/E-agriculture
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Computer Models for understanding Plant process 
The use of computational techniques increasingly permeates developmental biology, 

from the acquisition, processing and analysis of experimental data to the construction of models 
of organisms. Specifically, models help to untangle the non-intuitive relations between local 
morphogenetic processes and global patterns and forms. We survey the modeling techniques 
and selected models that are designed to elucidate plant development in mechanistic terms, 
with an emphasis on: the history of mathematical and computational approaches to 
developmental plant biology; the key objectives and methodological aspects of model 
construction; the diverse mathematical and computational methods related to plant modeling; 
and the essence of two classes of models, which approach plant morphogenesis from the 
geometric and molecular perspectives. In the geometric domain, we review models of cell 
division patterns, phyllotaxis, the form and vascular patterns of leaves, and branching patterns. 
In the molecular-level domain, we focus on the currently most extensively developed theme: the 
role of auxin in plant morphogenesis. The review is addressed to both biologists and 
computational modelers. 

Computer controlled devices(Automated system) for Agri-
input Management. 

Automatic milking systems are computer 
controlled stand alone systems that milk the dairy 
cattle without human labor. The complete automation 
of the milking process is controlled by an agricultural 

robot, a complex herd management software, and 
specialized computers. Automatic milking eliminates 
the farmer from the actual milking process, allowing 
for more time for supervision of the farm and the 
herd. Farmers can also improve herd management 
by using the data gathered by the computer. By 
analyzing the effect of various animal feeds on milk 
yield, farmers may adjust accordingly to obtain 
optimal milk yields. Since the data is available down to individual level, each cow may be 
tracked and examined, and the farmer may be alerted when there are unusual changes that 
could mean sickness or injuries.  

Smart phone Apps in Agriculture for farm devices 
The use of mobile technologies as a tool of intervention in agriculture is becoming 

increasingly popular. Smartphone penetration enhances the multi-dimensional positive impact 
on sustainable poverty reduction and identify accessibility as the main challenge in harnessing 
the full potential (Silarszky et al., 2008) in agricultural space. The reach of smartphone even in 
rural areas extended the ICT services beyond simple voice or text messages. Several 
smartphone apps are available for agriculture, horticulture, animal husbandry and farm 
machinery. 

Smartphone mobile applications designed and developed by Jayalaxmi agrotech Pvt Ltd 
from India are the most commonly used agriculture apps in India. Their mobile apps are in 
regional language are designed to break the literacy barrier and deliver the information in most 
simple manner. Several thousands of farmers across Asia are empowered with these apps. 

Post Harvest Management  
Augmentation of agricultural productivity needs a concurrent development of post 

harvest support mechanism including normal and cold storage facilities, packaging facilities, 
agro processing industries, crop sterilization and sanitation facilities and an effective marketing 
reach to global markets. Food processing adds value to the agricultural, horticultural, livestock 
and fisheries products by using various techniques like grading, sorting and packaging, etc. 
which enhances Table 3.3.2: Existing Storage Capacity of Cold Storage Units (in MT) S.No. 

https://en.wikipedia.org/wiki/Automatic_milking
https://en.wikipedia.org/wiki/Agricultural_robot
https://en.wikipedia.org/wiki/Agricultural_robot
https://en.wikipedia.org/wiki/Fodder
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Cold Storage No. Capacity 1 Cold storage at Farmers' Markets (Walk-in coolers) 27 54 2 
Tomato market complex- Maicheri, Salem district. 1 100 3 Hilly vegetables market complex-
Karamadai, Coimbatore district 1 50 4 Onion and other vegetables market complex-Perambalur 
district. 1 50 5 Chillies market complex-Paramakudi, Ramnad district. 1 100 6 Mango market 
complex - Krishnagiri district. 1 50 7 Tomato market complex - Palacode, Dharmapuri district. 1 
50 8 Onion market complex-Pongalur, Thiruppur district. 1 50 9 Grapes market complex- 
Odaipatti, Theni district. 1 50 Total 35 554 Source : Dept. of Agricultural Marketing and Agri 
Business, GoTN their shelf life. It leads to diversification of agricultural activities, improves value 
addition opportunities and creates surplus for export of agro food products. In Tamil Nadu, 
about 188 L.MT. of fruits and vegetables are produced. Due to heavy post harvest losses, there 
exists a considerable gap between gross production and net availability to the consumers. The 
post harvest loss is estimated at 30 to 40 percent in fruits and vegetables, which is primarily 
due to non adoption of post harvest management technologies. The post harvest losses start in 
the farm and travel along procurement chain and entire marketing channel. Adoption of post 
harvest technology and growth of food processing industries are inter-related as post harvest 
management increases the shelf life of fruits and vegetables and feed more to the agro 
processing industries. 

 
 
Geospatial technology for generating valuable agri 
information 

In agriculture, the use of the Global Positioning System provides benefits in geo-

fencing, map-making and surveying. GPS receivers dropped in price over the years, making it 
more popular for civilian use. With the use of GPS, civilians can produce simple yet highly 
accurate digitized map without the help of a professional cartographer. 

In Kenya, for example, the solution to prevent an elephant bull from wandering into farms 
and destroying precious crops was to tag the elephant with a device that sends a text message 
when it crosses a geo-fence. Using the technology 
of SMS and GPS, the elephant can roam freely and the 
authorities are alerted whenever it is near the farm.  

Geographic information systems 
Geographic information systems, or GIS, are 

extensively used in agriculture, especially in precision 

farming. Land is mapped digitally, and pertinent geodetic 
data such as topography and contours are combined 
with other statistical data for easier analysis of the soil. 
GIS is used in decision making such as what to plant 
and where to plant using historical data and sampling. 

https://en.wikipedia.org/wiki/Global_Positioning_System
https://en.wikipedia.org/wiki/Geofencing
https://en.wikipedia.org/wiki/Geofencing
https://en.wikipedia.org/wiki/Map_making
https://en.wikipedia.org/wiki/Surveying
https://en.wikipedia.org/wiki/Cartographer
https://en.wikipedia.org/wiki/Kenya
https://en.wikipedia.org/wiki/SMS
https://en.wikipedia.org/wiki/Geographic_information_system
https://en.wikipedia.org/wiki/Geographic_information_system
https://en.wikipedia.org/wiki/Precision_agriculture
https://en.wikipedia.org/wiki/Precision_agriculture
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Decision support system, concept, component and 
application in agriculture 

A rapidly changing world with high rates of population growth and major changes in political and 

economic systems has created an urgent need to develop new and revise many existing agricultural 

systems. During the next decade, changes will be made in infrastructures that support agricultural 

production, marketing, and distribution, in farms and their enterprises and practices, and in governmental 

policies and regulations that affect production, natural resources, and the environment. Now, more than 

ever, decision makers at all levels need an increasing amount of information to help them understand the 

possible outcomes of their decisions and develop plans and policies for achieving their goals. Decision 

Support Systems (DSS) are "interactive computer-based systems that help decision makers utilize data 

and models to solve unstructured problems" (Sprague and Carlson 1982). The goal of such systems is to 

improve the performance of decision makers while reducing the time and human resources required for 

analyzing complex decisions. In concept, DSS should support all phases of a decision making process, 

characterized by Simon (1960) as:  

(i) searching for conditions calling for a decision by identifying possible problems or 

opportunities;  

(ii) creating and analyzing possible courses of action; and  

(iii) Suggesting a course or courses of action from those analyzed.  

Most of the relatively few agricultural decision aids that have been developed are aimed at the 

farmer as a decision maker, and attempt to improve operational decisions such as pest control (Hearn 

1987; Michalski et al. 1983) fertilizer management (Yost et al. 1988), or a wider set of crop management 

decisions (Plant 1989; McKinion et al. 1989). The need for agricultural decision support systems extends 

beyond those for field level operational decisions with the farmer as a decision maker. A different 

approach was taken by a group of cooperating scientists in the IBSNAT project. The Decision Support 

System for Agrotechnology Transfer (DSSAT) was designed for users to easily create 'experiments' to 

simulate, on computers, outcomes of the complex interactions between various agricultural practices, 

soil, and weather conditions and to suggest appropriate solutions to site specific problems (Jones 1986; 

Uehara 1989). This system relies heavily on simulation models to predict the performance of crops for 

making a wide range of decisions. This system has been in use for almost three years. It is time to 

evaluate this approach and determine priorities for further development of these tools. In this paper, an 

overview of the DSSAT will be given, including limitations and major enhancements now being made to 

this field-scale system. Concepts will be presented for broader decision support systems to help identify 

problems in existing or proposed agricultural systems and to analyze the outcomes of practices and 

policies at farm and regional scales. 
 

Expert system, Soil Information systems etc for support 
farm decision 

Agricultural production system has been evolving into a complex business system requiring the 

accumulation and integration of knowledge and information from many diverse sources. In order to 

remain competitive, the modern farmer often relies on agricultural specialists and advisors to get 

information for decision making. Unfortunately assistance of the agricultural expert is not always 

available when the farmer needs it. In order to alleviate this problem, expert systems were identified as a 

powerful tool with extensive potential in agriculture.  

An Expert System (ES), also called a Knowledge Based System (KBS), is a computer program 

designed to simulate the problem-solving behavior of an expert in a narrow do main or discipline. The 

expert system could be developed for decision-making and location specific technology dissemination 

process. An expert system is software that attempts to reproduce the performance of one or more human 

experts, most commonly in a specific problem domain, and is a traditional application and/or subfield of 

artificial intelligence. 5 Expert systems helps in selection of crop or variety, diagnosis or identification of 

pests, diseases and disorders and taking valuable decisions on its management. The expert system which 
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developed earlier were more of text based and could be utilized only by the extension officials and 

scientists.  

Keeping the importance of ICT enabled interventions in agriculture and providing timely expert 

advise to farmers, the expert system on agriculture and animal husbandry was proposed and obtained as 

net work project from Indian Council of Agricultural Research. The 426 aim of the project is to develop 

expert system for agriculture (Paddy, Sugarcane, Banana, Ragi and Coconut) and animal husbandry for 

the three state in their respective languages ie., Tamil Nadu (Tamil), Karnataka (Kannada) and Kerala 

(Malayalam).  

Meaning, Importance and Early efforts  

a. Expert system meanings  

An Expert System is a computer program that stimulates the judgment and behaviour of a 

human (or) an organization that has expert knowledge and experience in a particular field. It is 

program that emulates the interaction a user might have with a human expert to solve a problem. 

An Expert System is a problem solving and decision making system based on knowledge of its 

task and logical rules or procedure for using knowledge. Both the knowledge and the logic are 

obtained from the experiences of a specialist in the area (Yogesh Kumar et al).  

Expert System are recognized as an appropriate technology because they address the problem 

of transferring knowledge and expertise from highly qualified specialists to less knowledgeable 

personnel. In agriculture, this transfer is always taking place from research to extension, from 

extension to farmers, and even from farmers to farmers. Expert system present excellent tools for 

relieving the increasing pressure on the limited expertise available in developing nations. It must 

be recognized that knowledge, the very foundation of 427 expertise, is a scarce resource in 

developing nations. Expert System can help expand this vital resource by making available, in 

specific situations, vital knowledge that increase the effectiveness of less experienced personnel ( 

Rafea et al ,1996 ).  

The Expert System uses a hierarchical classification and a mix of the text description; 

photographs and artistic pictures. The system involves two main sub tasks, namely diagnosis and 

management. The system designed and developed using visual basic as front- end and Microsoft 

Access as back- end software ( Vinod Kumar et al, 2008 ).  

An Expert System is a computer program normally composed of a knowledge base, influence 

engine and user-interface. Expert system in the area of agriculture and describes the design and 

development of the rule based expert system, using the shell ESTA (Expert System for Text 

Animation). The designed system is intended for the diagnosis of common diseases occurring in 

the rice plant. ESTA programming is based on logic programming approach. The system 

integrates a structured knowledge base that contains knowledge about symptoms and remedies of 

diseases in the rice plant appearing during their life span ( Shikhar et al)  

An Expert System is defined as “ a computer program designed to model the problem solving 

ability of a human expert ” (Durkin,1994). It is also defined as “a system that uses human 

knowledge captured in a computer to solve problems that ordinarily require human expertise”. 

Expert System increases the probability, frequency and consistency of making good decisions, 

additive effect of knowledge of many domain experts, facilitates real time, low – cost expert level 

decisions by the nonexpert enhance the utilization of most of the available data and free the 428 

mind time of the human expert to enable him or her to concentrate on creative activities. Expert 

System offers an environment where the good capabilities of humans and the power of computer 

can be incorporated into overcome many of the limitations (Mercy Nesa Rani et al,2011). 

b. Importance of Expert System  

The complexity of problems faced by the farmers are yield loses, soil erosion, selection of 

crop, increasing chemical pesticides cost, pest resistance, diminishing market prices from 

international competition and economic barriers hindering adoption of farming strategies. Expert 

System are computer program that are different from conventional computer programs as they 

solve problems by mimicking human reasoning process, relying on logic, belief, rules of thumb 

opinion and experience.  
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In agriculture Expert System are capable of integrating the perspectives of individual 

desciplines such as plant pathology, entomology, horticulture and agricultural meteorology into a 

framework that best address the type of ad hoc decision making required of modern farmers. 

Expert system can be one of the most useful tools for accomplishing the task of providing growers 

with day to day integrated decision support needed to grow their crops.  

c. List of Expert System in Agriculture  

The works carried out on Expert System in agriculture and allied field and various software 

used to develop an Expert System by authors were collected worldwide and presented as follows. 

PROLOG PASCAL SOYGRO  

 


